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Preface 

Vocational Education is a dynamic and evolving field, and ensuring that every student has access 

to quality learning materials is of paramount importance. The journey of the PSS Central 

Institute of Vocational Education (PSSCIVE) toward producing comprehensive and 

inclusive study material is rigorous and time-consuming, requiring thorough research, 

expert consultation, and publication by the National Council of Educational Research and 

Training (NCERT). However, the absence of finalized study material should not impede 

the educational progress of our students. In response to this necessity, we present the 

draft study material, a provisional yet comprehensive guide, designed to bridge the gap 

between teaching and learning, until the official version of the study material is made 

available by the NCERT. The draft study material provides a structured and accessible set 

of materials for teachers and students to utilize in the interim period. The content is 

aligned with the prescribed curriculum to ensure that students remain on track with their 

learning objectives. 

The contents of the modules are curated to provide continuity in education and maintain 

the momentum of teaching-learning in vocational education. It encompasses essential 

concepts and skills aligned with the curriculum and educational standards. We extend 

our gratitude to the academicians, vocational educators, subject matter experts, industry 

experts, academic consultants, and all other people who contributed their expertise and 

insights to the creation of the draft study material. Special thanks to Dr. Pankaj Chauhan, 

Associate Professor, Galgotias University, Greater Noida, UP, for his contribution in 

providing the software (SOLIDWORKS Education Edition 2025 SP3.0, Dassault Systèmes) 

support. 

Teachers are encouraged to use the draft modules of the study material as a guide and 

supplement their teaching with additional resources and activities that cater to their 

students' unique learning styles and needs. Collaboration and feedback are vital; 

therefore, we welcome suggestions for improvement, especially by the teachers, in 
improving upon the content of the study material. 

This material is copyrighted and should not be printed without the permission of the 

NCERT-PSSCIVE. 

 

Deepak Paliwal  
(Joint Director)  
PSSCIVE, Bhopal 

Date: 18th Aug 2025  
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Module Overview 

 

This module provides a comprehensive introduction to Computer-Aided Design (CAD) and 

its significance in the field of engineering and technology. It covers the fundamentals of 

CAD systems, the role of computers in design processes, and the interaction between users 

and software tools. Learners will gain practical exposure to drafting techniques using CAD 

software, enabling them to create precise and standardized technical drawings. The 

module aims to build a strong foundation in digital design, preparing students for more 

advanced applications in engineering design and manufacturing. 

 

 

Learning Outcomes 

 

After completing this module, you will be able to: 

• Understand what engineering drawing is and why it is important. 

• Operate computer for basic drawing tasks. 

• Recognize the names and uses of different CAD software. 

 

 

Module Structure 

 

Session 1: Introduction to Computer Aided Design (CAD) 

Session 2: Computer Interaction with CAD Software 

Session 3:  CAD software for Drafting Applications 

 

 

Imagine you are an architect designing a stunning new building, or an engineer crafting 

the intricate parts of a racing car. How do these amazing concepts go from a mere thought 

to comprehensive blueprints that are prepared for building? Computer-Aided Design 
(CAD) holds the key.  

This unit is your very first step into the exciting world of CAD. We will explore what CAD 

is, why it's a superpower for designers, and how your computer acts as your ultimate 

design partner. We will make everything clear and simple, ensuring that you grasp every 
concept. 

 

 

MODULE 1  FUNDAMENTALS OF CAD 
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SESSION 1: INTRODUCTION TO COMPUTER AIDED DESIGN (CAD) 
 

 

Consider creating a precisely square table. It could be difficult to get every corner 

precisely 90 degree and every side perfectly straight if you were drawing it by hand. What 

happens if you decide at the last minute that the table needs to be 10 cm longer? It would 

be a pain to redo. CAD can help in this situation. 

Computer-aided design, or CAD, is the process of creating, modifying, analysing, or 

optimizing any type of design using specialized computer software. You use a mouse, 
keyboard, and computer screen in place of a pencil and paper (Figure 1.1).  

 

Earlier to CAD                    In CAD 

 

    

 

 

 

 

 

Figure 1.1: Requirement of Drawing with and without CAD 

With the help of CAD software, you can create virtual three-dimensional (3D) models of 

your ideas and draw with amazing accuracy. 

CAD is essentially your digital workshop where you can easily and precisely design nearly 
anything. 

Some everyday examples of what CAD helps design: 

• Automobiles: Every car, truck, and motorcycle part, from the engine to the 
smallest screw. 

• Buildings: The entire plan of a house, a skyscraper, or even a city layout. 
• Consumer Products: Your smartphone, the chair you sit on, even the shape of a 

water bottle. 
• Machinery: Complex factory machines, robots, and industrial equipment. 

 

1.1 Why is CAD Important?  

Why has CAD become so essential in almost every industry? Because it offers truly 

powerful benefits that traditional drawing just can't match: 
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1.  Pinpoint Accuracy: CAD ensures every line, curve, and measurement in your design 

is perfectly exact. This means fewer mistakes when the actual product is manufactured, 

saving time and materials. Imagine designing a gear; CAD ensures its teeth fit perfectly 
with another gear. 

2. Blazing Speed: You can draw, copy, and modify designs much, much faster with CAD. 

In case you need 50 identical bolts? CAD can duplicate them instantly. Changes that would 
take hours by hand can be done in minutes. 

3. Effortless Editing: Made a mistake or want to try a different idea? No need to erase 

and redraw everything. CAD allows you to easily move, rotate, resize, or delete parts of 

your design with a few clicks, making revisions quick and simple. 

4. Seamless Sharing: CAD designs are digital files. This means you can instantly share 

them with colleagues, clients, or manufacturers across the globe via email or cloud 

services. Everyone works from the most updated version. 

5. Smart Cost Savings: By designing precisely and simulating how things will work on 

the computer, companies can catch potential errors early. Finding a mistake in a CAD 
model is much cheaper than finding it after the product has been built! 

6. Amazing 3D Visualization: Many CAD programs can create full 3D models. This lets 

you see your design from every angle, zoom in to tiny details, and even "explode" a 

complex assembly to see its individual parts. It's like holding a virtual version of your 

product before it's even made. 

Before you become a CAD master, let's understand the essential tools you'll be using: your 

computer and how it works to bring your designs to life. 

1.2 Applications of CAD (Where is CAD used?)  

Following are the applications of CAD Software: 

• CAD is not just for engineers: it is a tool that touches almost every part of our 

modern world.  

• Mechanical engineering:  The field that designs everything from large industrial 

machines, robots, and aerospace components to tiny gears and bearings. 

• Architecture and Construction: Developing intricate designs for homes, 

skyscrapers, bridges, interior spaces, and even city plans. 

• Product Design and Manufacturing: Developing the look and function of 

everyday items like mobile phones, furniture, appliances, shoes, and toys, then 

preparing them for mass production. 

• Civil Engineering: Planning infrastructure projects like roads, highways, dams, 

pipelines, and urban development. 

• Automotive Industry: Designing car bodies, chassis, engines, and all internal 

components. 

• Aerospace Industry: Designing aircraft, spacecraft, and satellites. 

• Fashion Design: Creating patterns for clothing and accessories. 

• Medical Field: Designing prosthetics, implants, and medical devices. 
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SESSION 2: COMPUTER INTERACTION WITH CAD SOFTWARE 
 

 

1.3 Understanding Your Computer 

Hardware & Software; Your Digital Toolkit; your computer is your workstation for CAD. 
It has two main parts working together: 

• Computer: This electronic device can quickly process information from your 

keyboard and mouse clicks, display your design on the screen, and provide you 

with results. It adheres to a set of guidelines known as "programs" or "software." 

 

• Windows Operating System (OS): The most crucial piece of software on your 

computer is this one. Consider it your computer's manager. It manages everything, 

including file organization and the operation of your CAD program. It provides a 

user-friendly visual interface (with windows and icons) for communicating with 

the computer's hardware. Your computer is nothing more than a box of parts 

without an operating system. 

 

• File Management System: This is a part of your operating system (like "File 

Explorer" in Windows). It's your digital filing cabinet! It helps you create, rename, 

move, copy, and delete your digital files and folders, keeping your designs 

organized and easy to find later. Figure 1.2 shows the computer interaction with 

CAD software. 

 

Figure 1.2: Computer Interaction with CAD Software 
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1.3.1 Computer Hardware Basics (The Physical Parts): Hardware is anything you can 
physically touch on your computer. 

• External Hardware (Peripherals): These are devices connected to your 

computer from the outside. It can be divided into two categories; input and output 

devices. 

➢  Input Devices (Putting Information In): These devices send information to the 

computer. 

Example 
• Keyboard: For typing text and commands. 
• Mouse: For clicking, selecting, and drawing. 
• Touchpad: (on laptops) A flat surface for finger gestures. 
• Microphone: For audio input. 
• Webcam: For video input. 
 

➢ Output Devices (Getting Information Out): These displays or deliver 

information from the computer. 

Example: 
• Monitor (Screen): Shows your design as you create it. 
• Printer: For creating physical copies (printouts) of your designs. 
• Speakers: For audio output. 
• Projector: For displaying your design on a large screen. 

 
• Internal Hardware (Inside the Box): These powerful parts are hidden inside 

your computer case. 

Example: 

• CPU (Central Processing Unit): Frequently referred to as the computer's 

"brain." It ensures that CAD software runs smoothly by carrying out all 

calculations and program instructions. 

• RAM (Random Access Memory): This is the short-term memory of the 

computer. It allows the CPU to quickly access information and speeds up 

the response of your CAD software by temporarily storing programs and 

data that are currently in use. 

• Hard Disk Drive (HDD) / Solid State Drive (SSD): This is the long-term 

storage for the computer. Even when the computer is off, it permanently 
saves all your documents, programs, and files (including CAD software). 

1.3.2 Computer Software Basics (The Instructions): Software is the set of instructions 

that tells the hardware what to do. 

System Software: This software offers a platform for application software to run on and 

aids in managing and controlling the computer hardware. It keeps your computer 
running. 
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Example: 

• Operating Systems (OS): (e.g., Windows, MacOS, Linux); the master program that 

manages everything. 

• Device Drivers: Tiny apps that let your operating system talk to certain hardware 

(such as your graphics card or printer). Your hardware may not function if the 

driver is incorrect. 

• Utility Software: Programs that help maintain and optimize your computer (e.g., 

antivirus software, disk clean-up tools).  

1.3.3. Application Software (Apps): These are applications made specifically to assist 
you, the user, in completing a task. This includes CAD software. 

Example: 

• Word Processors: (e.g., Microsoft Word) for writing documents. 

• Web Browsers: (e.g., Google Chrome, Firefox) for accessing the internet. 

• Graphics Software: (e.g., CAD programs like AutoCAD, SolidWorks, Photoshop) 

for creating and editing visuals.  

This flow is explained in Fig.1.3.  

  

 
 

Figure 1.3: Understanding Your Computer 
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How is Application Software Installed? You can get application software in a couple of 
common ways: 

• From a CD/DVD (Older Method): You insert a disc into your computer's drive 
and follow the on-screen instructions. 

• Downloading from the Internet (Common Method Today): You visit a 
website, download the software installation file, and then run it to install the 
program on your computer. 
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SESSION 3: CAD SOFTWARE FOR DRAFTING APPLICATIONS 

 

1.4 Types of CAD Software (Your Design Tools) 

There are numerous CAD software programs, just as there are various kinds of tools for 

various tasks. While some are more general-purpose, others are better suited for 
particular tasks. Here are some well-known ones that you may have heard of: 

• AutoCAD: One of the oldest and most widely used CAD software, especially strong 
for 2D drafting and technical drawings. Many industries use it. 
 

• Solid Works: Very popular for 3D mechanical design. It is known for its user-
friendly interface and powerful 3D modeling capabilities. 
 

• Fusion 360 (Autodesk): CAD combined with CAM (Computer-Aided 
Manufacturing) and CAE (Computer-Aided Engineering) tools on a contemporary 
cloud-based platform. It's excellent for hobbyists and product designers. 
 

• Tinkercad: Autodesk's free online 3D design tool. It is very easy to use, making it 
ideal for novices who want to learn the fundamentals of 3D modeling before 
advancing to more sophisticated software. 
 
 

• CATIA: A high-end, very powerful CAD software used mainly in the automotive 
and aerospace industries for complex designs. 

While each software has its unique features and commands, the core ideas of using 

geometry, coordinates, and various tools to create designs remain consistent across all of 
them. 

1.5 Advantages of CAD 

Computer-Aided Design (CAD) software offers many advantages in the field of design and 

drafting. It helps users create precise drawings, save time, and make quick changes when 

needed. The following points highlight some of the major benefits of using CAD software: 

1.  High Accuracy 

• With CAD, you can create designs that are incredibly accurate, down to the 
millimetre.  

• Making hand drawings can result in errors. Decimals are not forgotten by CAD. 
 

2.  Saves Time 

• Compared to traditional drawing, you can design more quickly. 
• Repetitive designs? Simply copy and edit!  
• There's no need to redo everything every time. 
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3. Easy to Edit 

• Did you make a mistake? No issue. To make changes, simply click or undo.  
• Erasing is the act of editing on paper. CAD editing is as easy as clicking. 

 

 4. Reuse Old Designs 

• You can use your past models in new projects. 
• Design a wheel once and use it in every vehicle model you make. 

 
5.  Professional Drawings 

• CAD can automatically make technical drawings for manufacturing. 
• It adds all the sizes (dimensions) perfectly. 

 

6.  Easy Sharing 

• Send your design to anyone: engineers, teachers, 3D printers via email. 
• No need to courier big paper blueprints anymore. 

 

1.6 Disadvantages of CAD 

While CAD software is very useful, it also has some drawbacks. Following are the 
disadvantages of it:  

1.  Requires a Computer 

• A decent computer with adequate memory and speed is essential.  

• Slow or outdated PCs may lag or crash when using CAD. 
 

2.  Needs Training 

• You need to become proficient with the software.  
• It is not something you can do right away, but it's simple once you practice. 

 
3.  Software Can Be Expensive 

• Professional CAD software like SolidWorks costs money. 
• However, student versions are often free or discounted. 

 
4.  Dependent on Electricity 

• No electricity or power? You can’t use CAD.  
• Unlike a paper drawing, you can't just take it outdoors. 

 
5.  Cannot Replace Human Creativity 

Although CAD is a tool, you are still responsible for coming up with the design concepts! 
Though it won't do all the thinking, the software is helpful. 
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What we Have learned so far? 

 
You have just completed your first big step in understanding CAD. In this unit, you 
learned: 

• CAD's definition: For accurate design, computers are used. 
• The importance of CAD is for precision, quickness, effortless editing, sharing, 

financial savings, and breath-taking 3D views. 
• Your computer's role: Understanding hardware (CPU, RAM, Hard Disk), 

software (OS, Application Software), and how to manage your design files. 
• Basic CAD interaction: How to use ribbons, toolbars, and the command prompt 

to create 2D objects. 
• Where CAD is used: In almost every industry, from cars to clothes! 
• Different CAD software: A quick look at some popular options. 

 
 

 
ACTIVITIES 

 
 

Activity 1: Think & Brainstorm 

Name three things you used today, such as a bicycle, a water bottle, or your school bag. 

Which of these items, in your opinion, was created using CAD? Justify your position. 

Let's say you have to create a basic mobile phone stand. Which CAD advantages over hand 
drawing would be most useful for this project? 

 

 

Activity 2: Exploring Your File System 

Aim: Get comfortable navigating and organizing files. 

Procedure: 

Step 1: Open File Explorer (You can usually find its icon on the taskbar, or press Windows 

key + E). 

Step 2: Navigate to your D: drive (or another drive if D: is not available, ask your 

instructor if unsure). 

Step 3: Create a new folder named MyCADProjects. 

Step 4: Inside MyCADProjects, create two sub-folders: Unit1_Practices and Future 

Designs. 

Step 5: Take a screenshot of your MyCADProjects folder showing the two sub-folders and 
show it to your instructor. 
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Activity 3: Finding Computer Information 

Aim: Locate basic information about your computer's hardware and OS. 

 Procedure: 

 Step 1: Right-click on the "This PC" icon (or "Computer" icon) on your desktop or in File 

               Explorer. 

 Step 2: Select "Properties." 

 Step 3: Note down the following information: 

• Your Windows Edition (e.g., Windows 10 Pro) 

• Your Processor (CPU) type (e.g., Intel Core i5)  

• Installed RAM (e.g., 8.00 GB) 

 Step 4: Share this information with your instructor or classmates. 

 

 

 

A. Multiple Choice Questions 

1. What does CAD stand for? 

A. Computerized Artistic Design 

B. Computer-Aided Drawing 

C. Computer-Aided Design 

D. Complex Architecture Design 

2. Which of the following is NOT an input device used in CAD? 

A. Keyboard 

B. Mouse 

C. Monitor 

D. Touchpad 

3. Why is CAD preferred over manual drawing? 

A. It reduces computer usage 

B. It promotes hand skills 

C. It provides precision and easier modifications 

D. It requires no training 

      

CHECK YOUR PROGRESS 
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4. What is the function of RAM in a CAD system? 

A. Permanent storage of files 

B. Short-term memory for quick data access 

C. To connect with input devices 
D. To display CAD models 

5. Which CAD software is most suitable for beginners and education? 

A. CATIA 

B. AutoCAD 

C. Tinkercad 
D. SolidWorks 

 

B. Match the following  

 

Column A Column B 

1. 
 

CAD A. The "brain" of the computer that 
performs calculations 

2. CPU B. The software that manages your 
computer's resources and lets you 
interact with it. 

3. CPU C. Program like CAD, a web browser, or a 
word processor, designed for specific 
tasks. 

4. Operating System D. A digital drawing board that uses 
computers for design. 

5. Application Software E. The screen that displays your computer's 
output. 

 

 

C. Fill in the blanks 

1. The __________ is often referred to as the "brain" of the computer and runs CAD 

software efficiently. 

2. A __________ is an input device used to type commands and text into CAD software. 

3. In the field of __________ engineering, CAD is used to design machines, robots, and 

factory equipment. 

4. CAD software can help users make __________ to their designs easily without 

starting from scratch. 

5. CAD designs can be shared quickly with others using the __________ or cloud storage. 
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D. Answer the following  

1. Explain in detail what CAD stands for and describe its importance in the modern 

design and engineering process. 

2. “Human creativity still important in the design process even though powerful CAD 

software is available to assist in drafting and modelling” Elaborate. 

3. Explain how output and input devices help while working on CAD software? 

4. Choose any one industry and describe how CAD software is used in that industry 

to improve work quality and efficiency? 

5. Write the advantages and disadvantages of using CAD. 
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Learning Outcomes 

 

After completing this module, you will be able to: 

• Draw basic shapes like lines, circles, and rectangles. 

• Turn 2D sketches into 3D models. 

• Use tools like fillet, chamfer, and mirror to improve their drawings. 

• Create patterns and make copies of shapes easily. 

 

 

Module Structure 

 

Session 1: Introduction to SolidWorks  
Session 2: Working with SolidWorks 
 

 

Have you ever wondered how 3D models are made on a computer? How do engineers 

design machines, tools, or even vehicles before building them? What software do they 

use, and how does it actually run? 

As we have now covered the basics of Computer-Aided Design (CAD), it is time to explore 

a professional software that brings designs to life. In this chapter, we will learn about 
SolidWorks, a widely used CAD software in the fields of engineering and product design.  

 

 

 

 

MODULE 2 LEARNING COMMANDS IN CAD 

Module Overview 

 

This module covers Computer-Aided Designing software that is SolidWorks which is 

widely used in the fields of engineering and product design. It is designed to familiarize 

students with the basic interface, tools, and commands required to create 2D sketches and 

convert them into 3D models. This module covers essential features such as drawing tools, 

dimensioning, and sketch modification techniques 
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Engineers and designers can create, alter, and visualize anything on a computer screen, 

from a basic keychain to a spaceship, with SolidWorks, which functions like an extremely 

intelligent digital toolbox. 

One of the most widely used CAD (Computer-Aided Design) software applications 

worldwide, it helps businesses design actual products before they are manufactured in 

factories. 

 2.1 Why Should You Use SolidWorks? 

The SolidWorks is perfect for the school students like you who are studying in Grade 11 

and 12. It is so because: 

• Easy to Learn, Fun to Use: SolidWorks is made to be easy to use and intuitive for 

novices. To begin creating, you do not have to be an expert in engineering. Simply 

click, drag, and shape.  You can use SolidWorks to design anything you can 

imagine. 

 

• Turns 2D Sketches into Realistic 3D Models: Have you ever sketched a phone 

or a car in your notebook? That flat drawing can be transformed into a realistic-
looking, spinnable 3D object in SolidWorks.  

Let’s try this! 

  
Draw a rectangle and boom.  Turn it into a box. 

 
 

• Used in Real-World Companies: Large companies like Samsung, Boeing, and 

even bicycle manufacturers use SolidWorks for product design. Learn this 

software now to launch your career! 

• Make Mistakes Without Worry: An incorrect cut on metal or wood is a major 

issue in real life. However, you can simply undo any mistakes you make in 

SolidWorks.  Do not waste any money or materials and try again.  It resembles an 

endless supply of tools and parts for a digital workshop. 

SolidWorks allows users to create accurate and detailed 3D models of different 

components and assemblies. 

 

SESSION 1: INTRODUCTION TO SOLIDWORKS  
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• You Can See How It Moves: Once you make parts, SolidWorks lets you put them 

together and see how they work, just like building a robot arm or a machine. 

• From Design to 3D Printing: Want to 3D prints your creation? SolidWorks 

designs can be easily exported and used with 3D printers to make real, touchable 

models. 

• Perfect for School Projects & Competitions: SolidWorks makes it simple to 

display expert designs, whether you're creating a science model, a car for a 

contest, or something for your school portfolio. Even technical drawings, 

animations, and exploded views can impress the judges during technical fests or 

Kaushal Utsav. 
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When you click on the SolidWorks application software, you get this starting interface. 

Figure 2.1 shows the window screen of the computer while open the software CAD 

considering the example of SolidWorks. Figure 2.1 represents the loading of the software. 

It takes a minute to completely open the software. In this book SOLIDWORKS Education 

Edition 2025 SP3.0 (c) 1995-2025 Dassault Systèmes is used for designing.  

 

Figure 2.1: Window Screen of the Computer 

Once the software is opened, the interface will be displayed as shown in Figure 2.2. Click 

on New from the drop-down arrow or press (Ctrl+N). 

 

SESSION 2: WORKING WITH SOLIDWORKS 
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 Figure 2.2: SolidWorks Interface 

On selecting New, a box appears, which asks the user to select any of the options (Figure 
2.3): 

 

 

Figure 2.3: SolidWorks Interface for Choosing the Type of Drawing 
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Part: Widely used to create three-dimensional (3D) designs for a simple design 

component. 

Assembly: A 3D representation of the combination of parts (assembly) constrained in a 

particular fashion to each other. 

Drawing: Representation of a 2D engineering drawing of a part or an assembly. 

2.2 Basic Features of SolidWorks Interface 

The Graphical interface opens on enabling 2D drafting (Figure 2.4). Select the required 

standard sheet size. 

 

 Figure 2.4: Step-by-Step of 2D Drawing   

You can also customise the sheet size and enter the required width and dimension by 

simply clicking on Custom Sheet Size (Figure 2.5). 
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Figure 2.5: Step-by-Step of 2D Drawing (Customize sheet size) 

 

Different features or command can be referred from Figure 2.6.   

 

 
 

Figure 2.6: Different Features or Command  
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Let us go through various features of SolidWorks: 

1. Graphics Area – Your Drawing Table 

This is the large area in the center of the screen that is either white or grey. Consider it 

your sketchbook. 

Everything you model or sketch shows up here. 

2. Feature Manager Tree – Your Model's Family Tree 

You’ll see a list of your actions and parts on the left side. This is called the Feature 

Manager Design Tree. 

It records every sketch, cut, or a hole you make. 

Imagine building a Lego model: this tree shows each block you used, in order. 

3. Command Manager – Your Toolbox 

A ribbon with buttons like Line, Circle, Extrude, and others is located at the top. We refer 

to this as the Command Manager.  

4. Menu Bar – The Control Center  

This bar is used to manage the whole project. Just above the Command Manager, this is 

where you can: 

• Save your file 

• Open a new design 

• Undo/Redo 

• Access settings 

5. Mouse Controls – Your Design Wand 

SolidWorks uses your mouse in following ways: 

• Left Click: Select objects and tools 

• Right Click: Open shortcut options 

• Scroll Wheel: Zoom in/out 

• Click + Hold Scroll Wheel: Rotate your model in 3D. 

2.3 Various Commands used in SolidWorks 

1. Line Command: helps to draw horizontal, vertical, or inclined lines (Figure 2.7). 
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Figure 2.7: Location of Line Command 

Click on the Line Tool. 

• Go to the Command Manager and click on the Line icon (or press the L key on your 

keyboard as a shortcut). Click to Set the Starting Point. 

• Move your cursor to the Graphics Area and left-click to start your line. 

Move Your Mouse to Set the Direction. 

• Drag your cursor in the direction you want the line to go (horizontal, vertical, or 

diagonal). Click Again to Set the End Point. 

• Left-click once more where you want the line to end. Press the ‘Esc’ Key to Exit the 

Line Tool. 

If you don’t want to draw more lines, press Esc on your keyboard; otherwise, from the 

current point, move the pointer to the next point till where you want to draw the new 

line, and so on. Figure 2.8 shows different kinds of lines that can be drawn. 
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  Figure 2.8: Different Ways to Draw the Lines  

Line Properties 

Refer Figure 2.9 to understand different ways of drawing the lines on the drawing sheet 

The important steps to use the different types of lines are as follows:   

• Click on the line. 

• Use Add Relations to make the horizontal, vertical, or fix it. 

• Use Parameters to give dimensions to the line. 

 

Figure 2.9: Different Ways to Draw the Lines on the Drawing Sheet 
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2. Circle: The Circle tool helps to draw circles (Figure 2.10). The steps to draw circles 

are as follows:  

1. Click on the Circle Tool. 

In the Sketch tab on the top toolbar, click the Circle icon. 

 (You can choose “Centre Circle” for now-it’s the easiest to use.) 

 

2. Click to Set the Centre of the Circle. 

Move your cursor into the Graphics Area and click once where you want the 

centre of your circle to be. 

 

3. Drag Outward to Set the Size. 

Move your mouse outward. A circle will start forming. 

 

4. Click Again to Finish the Circle. 

Left-click again to set the edge of the circle. That’s it—you’ve drawn a circle.  

 

5. Press ‘Esc’ to Exit the Tool. 

 
Figure 2.10: Location of Circle Tool 

The Circle Tool in SolidWorks is used to create circular geometry within the Sketch 

environment. It allows users to draw circles by selecting a centre point and defining the 

size using a radius or diameter (Figure 2.11).  
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Figure 2.11: Circle Tool Location in SolidWorks-For Radius-Based Sketching 

For precise design work, dimensions can be added manually or adjusted using the Smart 

Dimension Tool, where the radius can be specified to control the size of the circle 

accurately. The Circle Tool is essential for designing round features such as holes, bosses, 

and revolved parts in mechanical components.  

3. Rectangle tool: It helps to draw rectangles. The Rectangle Tool in SolidWorks 

helps users draw rectangular shapes in the Sketch environment efficiently. It is a 

fundamental tool used to create the base profiles of many mechanical parts. 

SolidWorks offers four types of rectangle drawing techniques, allowing flexibility 

based on design requirements (Figure 2.12): 

1. Corner Rectangle 

2. Center Rectangle 

3. 3-Point Corner Rectangle 

4. 3-Point Center Rectangle 
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Figure 2.12: Location of Rectangle Tool 

1. Corner Rectangle 

➢ Starts from one corner to the opposite corner. 

➢ Best for simple box shapes, plates, and frames. 

Steps: 

• Click Corner Rectangle. 

• Click to place the first corner. 

• Drag and click to place the opposite corner. 

2. Centre Rectangle 

➢ Starts from the centre point and expands outward. 

➢ Useful for symmetrical designs (e.g., bolts, wheels). 

Steps: 

• Click Centre Rectangle. 

• Click to set the centre. 

• Drag and click to set the size. 

3. 3-Point Corner Rectangle 

➢ Define one angled edge first, then the height. 

➢ Good for tilted or rotated plates. 

Steps: 

•  Click 3-Point Corner Rectangle. 

• Click two points for one edge. 
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• Click the third point to set the height. 

4. 3-Point Centre Rectangle 

➢ Define the centre and one edge, then the height. 

➢ Useful for symmetrical but angled rectangles. 

Steps: 

• Click 3-Point Centre Rectangle. 

• Click to set the Enter key. 

• Click again for width, then for height 

 

Figure 2.13: Drawing Centric and Centred Rectangles 

The top left is a corner rectangle, and the bottom right is a centred rectangle (Figure 2.13). 

NOTE: A centred rectangle is always shown by dotted (construction) diagonal lines. 
 

3. Arc: The Arc Tool in SolidWorks is used to create curved geometry within 

sketches. It supports drawing three types of arcs, each serving different design 

needs(Figure 2.14): 

a) CenterPoint Arc – Created by selecting the centre, start, and end points of 

the arc. 

b) Tangent Arc – Automatically connects to an existing sketch entity with 

tangency, ideal for smooth transitions. 
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c) 3-Point Arc – Defined by selecting the start point, end point, and a third 

point to control the arc's curvature. 

 

Figure 2.14: Location of Arc Tool 

1. CentrePoint Arc 

➢ Starts from the centre of the circle. 

Steps: 

1. Click CentrePoint Arc. 

2. Click to place the centre. 

3. Click to set the start point. 

4. Click again to set the endpoint. 

5. Best for precise arcs with a known centre. 

6. A Centre Point arc is shown by the start point, end point, and the arc’s 

centre (Figure 2.15). 
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Figure 2.15: CenterPoint Arc 

2. Tangent Arc 

➢ Drawn directly from the end of a line or arc to make a smooth, continuous curve. 

Steps: 

1. Start drawing a line or arc. 

2. Without exiting, click Tangent Arc. 

3. Drag to form a smooth arc connected to the previous line. 

Best for flowing shapes like cams or curved profiles (Figure 2.16). 
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  Figure 2.16: Tangent Arc 

 

3. Three-Point Arc 

➢ Defined by start point, end point, and a third point that controls the arc’s curve. 

Steps: 

1. Click 3-Point Arc. 

2. Click to place the start point. 

3. Click to set the endpoint. 

4. Click a third point to adjust the bulge/curve. 

A three-point arc is represented by the 3 points with which it has been drawn 

(Figure 2.17). 
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Figure 2.17: Three-Point Arc 

4. Polygon tool: The Polygon Tool in SolidWorks is used to draw regular polygons 

shapes with equal-length sides and equal angles. You can create shapes such as 

triangles, pentagons, hexagons, and more by specifying the number of sides and 

selecting a center point. The polygon can be inscribed in or circumscribed about a 

circle, and its orientation can be adjusted as needed. This tool is useful for designing 

symmetric components and patterns in mechanical and structural designs (Figure 

2.18). 

 

Figure 2.18: Location of Polygon Tool 
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Steps to Draw a Polygon (Figure 2.19): 

1. Select the Polygon Tool: Click the Polygon icon in the Sketch toolbar. 

2. Set Number of Sides: A small box appears - type how many sides you want (e.g.,   

6 for a hexagon). 

3.  Select circumscribing or inscribing as per your requirement. 

4. Place the Polygon: Following steps are to be followed: 

1. Click once to set the centre point.  
2. Drag outward and click again to fix the size. 
 

Choose Orientation (Optional) 

• You can tick “For construction” to make it reference-only. 

• You can also rotate it slightly if needed. 

Examples: 
• 3 sides → Triangle 
• 5 sides → Pentagon 
• 6 sides → Hex nut 
• 8 sides → Octagonal cover  

 

 

Key Tips: 

• All sides are equal by default. 

• You can dimension the edge length or overall diameter using Smart Dimension. 

• Works great for bolt heads, flanges, knobs, and other symmetric parts. 
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             Figure 2.19: Drawing Circumscribing Hexagon, an Inscribing Hexagon, and       

an Inscribed Pentagon 

5. Spline Tool: The Spline Tool is used to create smooth, free-form curves that are 

ideal for drawing complex shapes not possible with straight lines or arcs. Splines 

are highly flexible and can be adjusted by manipulating control points or handles, 

allowing precise shaping of curves. This tool is widely used in automotive, product, 

and mould design, where aerodynamic or organic forms are required. Splines can 

be dimensioned and constrained for accuracy, ensuring the curves meet design 

specifications. They are also useful for creating lofts, sweeps, and other advanced 

3D features in modelling (Table 2.1). 

Table 2.1: Description of Spline Tool 

Spline Type Description Applications 

Spline (Standard) Click multiple points to 

define a curve 

Free-flow designs, 

curves, handles 

Style Spline Defined by control 

points (like Bezier) 

Precise control, 

industrial designs 

 

Steps to Draw a Standard Spline (Figure 2.20): 

1. Open a sketch on a plane. 
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2. Go to Sketch tab → Spline. 

3. Click to place multiple points to shape your curve. 

4. Press Esc when done. 

5. Use handles or points to adjust the curve. 

Steps to Draw a Style Spline: 

1. Click the down arrow under Spline → Choose Style Spline. 

2. Click to place control vertices. 

3. The curve flows between points using mathematical control. 

 

Figure 2.20: Location of Spline Tool 

Now, after understanding various commands as mentioned above, the most important 

aspect of drawing – i.e., Dimensioning comes into picture.  

Smart Dimensioning in SolidWorks: 

Use the Smart Dimension tool to define the size, angle, and position of sketch elements. 

Figure 2.21 shows the location of Smart Dimension tool in SolidWorks.  

Common Steps: 

1. Open a Sketch. 

2. Click the Smart Dimension tool. 

3. Click on the sketch element. 

4. Move your mouse to place the dimension. 

5. Enter the value and press Enter. 
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Figure 2.21: Location of Smart Dimension Tool 

Smart Dimensioning Steps by Sketch Element: Refer to Table 2.2. 

Table 2.2: Smart Dimensioning Steps by Sketch Element  

Sketch Element What You Can Dimension Steps to Dimension 

Line Length, angle, distance Click on the line → Click again to place → 

Enter the length or angle 

Rectangle Length, width, location Click each side separately to add length & 

width → Click corners to set position 

Circle Diameter or radius, centre 

location 

Click on circle → Drag out dimension → 

Enter value; click center for position 

Polygon Side length, center distance Click one side → Enter length → Click 

center and side to set size and placement 
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Spline Point distances, handle length, 

tangents 

Click spline points → Add distances; click 

handles for curvature control 

Arc Radius, angle, chord length, 

center 

Click arc → Place radius; or click ends + 

arc for angle/chord → Enter value 

 

Pro Tip: 

• Green = Fully Defined, Blue = Under Defined. 
• Use Smart Dimensions + Relations for best results. 

 

With the help of the smart dimension tool, click on the line and enter the dimension 

(Figure 2.22). 

 

Figure 2.22: Length of Line 

The Angle between 2 lines can be made suing the process described in Figure 2.23. 
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Figure 2.23: Angle between Two Lines 

Click on the 1st line, then click the second line and enter the angle. Figures 2.24, 2.25, and 

2.26 show all possible ways to dimension an inclined line. 

 

Figure 2.24: Inclined Line Dimensioning-Vertical Length 
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Figure 2.25: Inclined Line Dimensioning- Horizontal Length 

 

Figure 2.26: Inclined Line Drawn  

Using the Smart Dimension Tool for Circles in SolidWorks 

To define the size of a circle using the Smart Dimension Tool in SolidWorks, follow these 

steps (Figure 2.27): 
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• Select the Smart Dimension Tool from the Sketch toolbar. 

• Click on the circumference of the circle in your sketch. 

• A dimension box will appear—enter the desired diameter value. 

• Press Enter to apply the dimension and fully define the circle. 

 

   Figure 2.27: Circle Dimensioning 

• Using the Smart dimension tool, select the circumference of a circle and enter the 

diameter. 

NOTE: In case of circles, the diameter is mentioned, while for arcs, the radius is 

mentioned. 

The process of determining the Rectangle length, Rectangle width and Distance between 

two (2) lines is shown in Figures 2.28, 2.29 and 2.30.  
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Figure 2.28: Rectangle - Length 

 

Figure 2.29: Rectangle - Width 
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Figure 2.30: Distance between 2 Lines 

When 2 lines are to be separated at a distance, it can be done by simply selecting a point 

on 1st line and another point on 2nd line and entering required dimension. 

2.4 Other important drawing tools: 

1. Fillet: Creates a smooth, rounded corner between two lines. 
    Steps: 

• Click Sketch Fillet. 

• Set the fillet radius. 

• Click on the two lines or corners to apply a fillet. 

• Used in designs where sharp corners are avoided. 

2. Chamfer: Adds a beveled edge instead of a round corner. 

      Steps: 
1. Click Sketch Chamfer. 
2. Set distance or angle values. 
3. Select two lines or a corner point. 

Useful in mechanical parts to remove sharp edges (Figure 2.31 and Figure 2.32).  



 
 
  

42 
 

42 DRAUGHTSMAN MECHANICAL – GRADE XII  

 

Figure 2.31: Location of Fillet and Chamfer Tool 

 

                       Figure 2.32: Fillet Command Use for Providing the Curvature at Ends 

Select 2 sides to fillet and enter the fillet radius 

Select 2 sides to chamfer and enter the distance (Figure 2.33). 
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Figure 2.33: Chamfer Command Uses 

 

NOTE: You can vary the horizontal and vertical distance of the chamfer by selecting the 

distance-distance option. 

3.  Trim Entities: This command is used to remove extra or overlapping sketch lines 

(Figure 2.34). 

Steps: 

1. Click the Trim Entities from Sketch toolbar. 

2. Choose trim option (Power trim is most common). 

3. Click and drag over the part you want to remove. 

 
Tip: Use it to clean up corners or overlapping lines. 
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Figure 2.34: Location of Trim Tool 

4.  Linear Sketch Pattern: Repeats sketch features in a straight line (X or Y direction). 

Figure 2.35 and Figure 2.36 shows the location of linear and circular sketch patterns. 

Steps: 

1. Select the sketch object (e.g., circle, slot). 

2. Click Linear Sketch Pattern. 

3. Set the number of instances, spacing, and direction. 

4. Click   to apply. 

 

Ideal for creating rows of holes or slots. 
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Figure 2.35: Location of Linear and Circular Sketch Pattern 

 

Figure 2.36: Linear Pattern 

Select the edge along which you want your pattern, and then select the number of 

instances as required. 

5. Circular Sketch Pattern: Repeats sketch objects in a circular path around a center 
(Figure 2.37). Great for bolt circles or round part designs. 
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Steps: 
1. Select sketch entities (e.g., holes). 
2. Click Circular Sketch Pattern. 
3. Select a center point. 
4. Enter a number of copies and an angle. 
5. Apply the pattern. 

 

Figure 2.37: Circular Pattern 

6. Offset Entities: Creates a parallel copy of a sketch at a fixed distance (Figure 2.38 and 

Figure 2.39). Useful for making wall thickness or layering shapes. 

Steps: 

1. Click Offset Entities. 

2. Select the sketch entity (line, arc, etc.). 

3. Set the offset distance and direction. 

4. Click   to apply. 
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Figure 2.38: Location of Offset Tool 

 

Figure 2.39: Offset Command 

You can vary the above parameters to get the desired results as per your requirement. 

The Offset Entities can be used for both internal and external offsets, and it is useful for 

generating walls, gaps, or profiles with uniform spacing. You can also choose to reverse 

the direction and add caps to closed profiles when needed. 
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7. Mirror entities: The Mirror Entities tool creates a symmetrical copy of selected sketch 

elements across a defined line (mirror line). It is commonly used to design balanced or 

repetitive features efficiently. Any changes made to the original entities are automatically 

reflected in the mirrored copy, maintaining design consistency. 

Steps: 

1. Draw or choose a centreline as the mirror axis. 

2. Select sketch elements to mirror. 

3. Click Mirror Entities. 

4. Apply the mirror. 

Saves time in symmetrical designs. Figure 2.40 shows the location of mirror tool and 

Figure 2.41 shows the Mirror pattern.  

 

Figure 2.40: Location of Mirror Tool 
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Figure 2.41: Mirror Pattern 

 

 

Activity 1: Draw and Dimension a Keychain 

Aim:  To create a basic 2D sketch and add dimensions. 

Steps: 

1. Open SolidWorks and select New → Part → Sketch. 

2. Draw a rectangle and a circle inside it (like a keychain with a hole). 

3. Use the Smart Dimension tool to set the length, width, and hole size. 

4. Save your file. 

 

Activity 2: Make a 3D Box from a Rectangle 

Aim: To convert a 2D shape into a 3D model.  

Steps: 

1. Draw a rectangle on the sketch area. 

2. Click on the Features tab → Extruded Boss/Base. 

3. Set the height (e.g., 50 mm) to turn the rectangle into a box. 

4. Rotate the model using the scroll wheel. 

 

ACTIVITIES 
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Activity 3: Create a Bolt Head Using Polygon Tool 

Aim: To use the polygon tool and create a hexagonal shape. 

Steps: 

1. Select Polygon Tool and enter 6 sides. 

2. Draw a hexagon on the screen. 

3. Use Smart Dimension to set the size. 

4. Extrude the hexagon to make it a 3D bolt head shape. 

 

 

 

A. Multiple Choice Questions  

1. What is SolidWorks primarily used for? 

A. Image editing 

B. Video rendering 

C. 3D modeling and CAD design 
D. Web development 

2. Which SolidWorks tool is used to create a rounded edge on a part? 

A. Shell 

B. Fillet 

C. Chamfer 
D. Offset 

3. The feature used to create a cut or hole along a defined path in SolidWorks is: 

A. Loft 

B. Revolve 

C. Sweep Cut 
D. Mirror 

4. The “Sketch” environment in SolidWorks allows users to: 

A. Animate assemblies 

B. Apply materials 

C. Create 2D profiles for 3D features 
D. Create rendered images 

 

CHECK YOUR PROGRESS 
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5. Which command in SolidWorks creates a feature by rotating a sketch around an axis? 

A. Extrude 

B. Revolve 

C. Offset 

D. Pattern 

 

  B. Match the following  

 

Column A Column B 

1. 
 

Isometric View A. Creates a 2D profile for 3D features 

2. Smart Dimension          B. Adds a  beveled edge instead of a curve 

3. Chamfer           C. Used to add length, radius, or angle 
values 

4. Sketch D. Creates a 3D feature by rotating a sketch 

5. Revolve E. View showing 3D object from corner angle 

 

  C. Fill in the blanks  

 

1. SolidWorks is a _________ software used for designing. 

2. The _________ tool is used to draw straight lines. 

3. The _________ Pattern command is used to make repeated shapes in a line. 

4. The _________ tool is used to draw round shapes. 

5. _________entities is used to remove extra or overlapping lines. 

 

  D.   Answer the following  

1. What is SolidWorks and how is it useful for students? 

2. Explain the difference between Part, Assembly, and Drawing in SolidWorks. 

3. What is the purpose of the Smart Dimension tool? Describe how it works. 

4. Describe the steps to draw a circle and add its dimension in SolidWorks. 

5. What is the use of Mirror Entities in SolidWorks? Write the steps to use it. 

6. List and explain any three basic drawing tools available in SolidWorks. 
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Learning Outcomes 

 

After completing this module, you will be able to: 

• Create 2D views such as front, top, side, and isometric. 

• Use sketch tools to draw lines, rectangles, circles, and arcs. 

• Apply dimensions, centrelines, and notes. 

 

 

Module Structure 

 

Session 1: Introduction to 2D Drawing 

Session 2: 2D Drawing  in SolidWorks  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

What Maya did? She has done all the below points easily: 

MODULE 3 2D DRAFTING IN SOLIDWORKS  

Module Overview 

 

This module covers the process of creating 2D drawings from 3D models using 

SolidWorks. It mainly focuses on views, dimensions, annotations, and exporting drawings 

for manufacturing. 

Maya was a curious student who loved building things. One day, her 

teacher gave her a special challenge to create a detailed drawing of a 

mysterious machine part called the “Gearbox of Wonders”. But there 

was a twist: Maya only had the 3D model of the part on her computer! 

At first, Maya was confused. How could she explain the shape and size 

of this complex part to the engineers and workers who would build it, 

inspect it, and keep it working perfectly? Then, her teacher introduced 

her to SolidWorks, a magical software that could turn any 3D model 

into clear, professional 2D drawings. These drawings would show 

every tiny detail from the exact length of a bolt hole to the precise 

angles of the gears so everyone could understand and build the part 

exactly right. 
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• View the 3D part from different angles, 

• Create 2D views like front, top, and side, 

• Add measurements and notes that tell the full story of the part, 

• Prepare drawings that could be used by real factories to make the machine. 

By the end of her adventure, Maya had created drawings so perfect that the Gearbox of 

Wonders came to life in the workshop, working smoothly and impressing everyone. Now, 

Maya was ready to bring any 3D design into the real world - one drawing at a time! 

 

Let us understand the steps to make 2D designs in detail. 
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In SolidWorks, 2D drawing involves creating accurate technical illustrations from 3D 

models to convey design details for manufacturing, assembly, and quality inspection. It 

enables designers and engineers to produce precise views; such as front, top, side, 

isometric, and section, along with dimensions, tolerances, annotations, and symbols. The 

software streamlines the process by automatically updating the drawing whenever the 

3D model is modified, ensuring consistency and precision. Following international 

drafting standards, these 2D drawings serve as vital documents for production, quality 

assurance, and effective communication between design and manufacturing teams.  

 

SolidWorks allows you to quickly generate 2D drawings directly from your 3D CAD 

models. The drawings are associative, meaning if you change the 3D model, the 2D 

drawing updates automatically. 

 

Even though 3D models are widely used, 2D technical drawings remain essential because 

they: 

 

➢ Provide clear instructions for manufacturing. 

 

➢ Serve as legal documentation of the design. 

 

➢ Are required for quality control and inspection. 

 

➢ Support communication between engineers, suppliers, and clients. 

 

 

 

 

 

 

 

SESSION 1: INTRODUCTION TO 2D DRAWING 
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As discussed in previous section, 2D Drawing is a flat, two-dimensional representation of 

a 3D model. It includes: 

➢ Different views (Front, Top, Right, Isometric) 

➢ Dimensions and tolerances 

➢ Notes and symbols 

➢ Title block and material info 

Different steps involved in 2D drawing are described in Table 3.1. 

Table 3.1: Steps used in 2D Drawing 

Step  Action Purpose 

1  Open SolidWorks and click File > New > Drawing Start a new drawing 

2 Select a sheet size (e.g., A4 ISO) and click OK Choose your drawing 
sheet 

3 Go to the Sketch tab and click Edit Sheet Format, or 
right-click and choose Edit Sheet 

Enter sketching mode 

4 Use Sketch Tools: Line, Rectangle, Circle, Arc, 
Polygon, Spline 

Draw your 2D geometry 
directly on the sheet 

5 Use Smart Dimension to add length, radius, angles, 
etc. 

Add exact measurements 

6 Add Center lines, Center Marks, and other detailing 
tools 

Improve drawing clarity 

7 Add Notes, material info, or text with the Note tool Provide necessary info 

8 Exit sketch mode by clicking Exit Sketch Finalize drawing 

9 Save the file or export it as PDF, DXF, or DWG For printing or submission 

Steps to create 2D drawing from a 3D part: 

1. Open the 3D part file in SolidWorks. 

2. Click File > Make Drawing from Part. 

3. Choose a drawing template (e.g., A4, A3). 

  
 

SESSION 2: 2D DRAWIING IN SOLIDWORKS 
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4. SolidWorks opens the drawing sheet. 

5. Drag and drop standard views like Front View, Top View, Right View, and 

Isometric View. 

Let us take an Example (Figure 3.1): 

 
Figure 3.1: A Two-Dimensional (2D) Drawing 

 

Steps to be followed: 

1. Select a start point and create a corner rectangle of length 70mm and width 

60mm. 

2. Trim the top line using the Trim entities command. 

3. You can also use the line command only. Select a start point → using the Line 

command. Draw a 60 mm vertical line → draw a 70 mm horizontal line 

perpendicular to the vertical line → draw the 60 mm vertical line from the end 

point. 

4. Use the tangent arc command to draw an arc of radius 35 mm. 

5. From the centre of the arc, draw a circle of 20 mm radius. 

6. From the midpoint of the 70 mm line, draw a horizontal line of length> 50 mm 

and 15 mm away. Similarly draw a vertical line of length 15 mm and 10 mm 

away from the 60 mm line. It should meet the horizontal line. 

7. Complete the rectangle shown. 

8. Trim the necessary entities. 
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 Activity 1: Create the following 2D drawing in SolidWorks 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ACTIVITIES 
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 Activity 2: Create the following 2D drawing in SolidWorks 

 

 

 

 

 

 

Activity 3: Create the following 2D drawing in SolidWorks  
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Activity 4: Create the following 2D drawing in SolidWorks  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A. Multiple Choice Questions  

1. What is the primary purpose of 2D drawings in SolidWorks? 

A. To animate 3D models 

B. To provide technical illustrations for manufacturing and inspection 

C. To create photo-realistic images 

D. To simulate motion 

2. Which command is used to remove extra lines in a 2D sketch? 

A. Mirror 

B. Offset 

C. Trim Entities 
D. Fillet 

3. Which of the following is a correct sequence to begin a 2D drawing from a 3D part? 

 

CHECK YOUR PROGRESS 
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A. Start new sketch > Add views > Save file 

B. File > New > Assembly 

C. File > Make Drawing from Part 
D. Tools > Evaluate > Export 

4. What is the purpose of a title block in a 2D drawing? 

A. To store the 3D model 

B. To include information like part name, date, and author 

C. To add animation 
D. To apply lighting effects 

5. Which tool would you use to draw an arc connected smoothly to a line? 

A. Offset Entities 

B. Tangent Arc 

C. Mirror Entities 
D. Convert Entities 

B. Match the following 

Column A Column B 

1. 
 

Spline Tool A. Creates multi-sided closed figures 

2. Polygon Tool B.  Draws complex, free-form curves 

3. Section View         C.  For compatibility with AutoCAD 

4. DWG D. Adds reference lines for symmetrical or 
circular features 

5. Center line Tool E. Shows internal features by cutting through 
the model 

 

C. Fill in the blanks  

1. 2D drawings serve as legal __________ of the design. 
 

2. To begin a new drawing in SolidWorks, click File > New > __________. 
 

3. Smart __________ tool is used to add exact dimensions like length, radius, and angle. 
 

4. The __________ arc command is used to draw an arc that smoothly connects two 
lines. 

 
5. The file can be saved or exported in formats like PDF, DXF, or __________. 

 

 D. Answer the following  

1. What is a 2D drawing and what key elements does it usually include? 
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2. List three types of views that can be added to a 2D drawing in SolidWorks. 

3. What tool is used to add exact measurements like lengths, angles, and radii in a 

2D drawing? 

4. What is the purpose of adding centerlines and center marks in a drawing? 

5. Describe the step-by-step process to create a 2D drawing from a 3D part in 

SolidWorks. 
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Learning Outcomes 

 

After completing this module, you will be able to: 

• Explain the concept of production drawings and justify their importance in the 

manufacturing process. 

• Create 2D production drawings from 3D models using SolidWorks. 

• Add dimensions, materials, surface finishes, and notes to your drawings. 

• Understand and use GD&T symbols to show tolerances. 

• Use the DimXpert tool in SolidWorks to apply geometric tolerances. 

 

 

Module Structure 

 

Session 1: Introduction to Production Drawing  

Session 2: Tolerance and its Symbols  

 

 

 

 

 

 

 

 

MODULE 4 READING PRODUCTION DRAWING 

Module Overview 

 

In this module, fundamentals of technical production drawings used in the manufacturing 

process are discussed. The focus will be on developing the skills required to convert 3D 

models into accurate 2D engineering drawings using SolidWorks. Participants will learn 

to include all essential details such as dimensions, material specifications, surface finishes, 

and tolerances to ensure that parts can be fabricated exactly as designed. 
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Rohit was a young inventor who dreamed of making robots. One day, he designed a cool 

robot arm on his computer using SolidWorks. It looked amazing in 3D, but when he 

wanted to build it, he realized the factory workers needed something more production 

drawings. These production drawings were like special instructions clear, precise, and 

easy to understand that showed every part of the robot arm with exact measurements 

and details. Without them, the workers wouldn’t know how to make each piece correctly. 

ohit felt stuck, but then his teacher taught him how to create production drawings in 

SolidWorks. Sam learned to: 

• Convert his 3D robot parts into flat 2D drawings, 

• Add all the important details like dimensions, material types, and surface finishes, 

• Include notes for the machinists so the parts could be made 

perfectly. 

With his new production drawings ready, Sam sent them to the 

factory. The workers followed his drawings carefully, and soon, the 

robot arm was built exactly as he imagined strong, smooth, and ready to 

work! 

From that day, Sam knew that production drawings in SolidWorks 

were the secret to turning ideas into real, working machines. 

And this is what you’ll learn in your book i.e., how to make perfect 

production drawings in SolidWorks so you can create things that 

really come to life! 
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SESSION 1: INTRODUCTION TO PRODUCTION DRAWING 

Production Drawing is a detailed technical drawing used in the fabrication or 

manufacturing of a part, component, or assembly. It is also referred to as a manufacturing 

drawing or shop drawing. It has all the details a machinist or manufacturer needs to make 

the item correctly. 

4.1 Key points about production drawings: 

• Purpose: To provide complete and precise instructions to manufacture a part or 

assembly. 

• Contents: dimensions, materials, surface finish, welding or assembly instructions, 

machining details, tolerances, and any additional special notes. 

• Views: Usually includes multiple views like front, top, side, sectional views, and 

detailed views. 

• Standards: To guarantee clarity and prevent mistakes, adhere to standard 

drawing conventions (ISO, ASME, or company standards). 

• Scale: Sometimes full size, but usually drawn to scale. 

• Notes on materials, finishes, heat treatments, and manufacturing procedures are 

included in the annotations. 

 Why are production drawings important? 

They serve as the manufacturing blueprint, guaranteeing that all production workers 

know precisely what needs to be made and how. So, a production drawing is a precise, in-

depth engineering drawing used by manufacturers to ensure that a part or assembly is 

produced precisely as intended (Figure 4.1). 

 

Figure 4.1: Production Drawing 
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1. Title Block: The Identity Card of the Drawing 

In the bottom corner of every drawing, there’s a box that acts like the drawing’s identity 
card. It tells you:  

• What the part is called 
• Who made the drawing and when 
• What material to use (steel, plastic, etc.) 
• What scale is used (for example, is the drawing smaller or bigger than the real 

part?) 
 

Why it matters: Just like we have names and ID numbers, every part needs to be 
correctly labelled so no confusion happens on the shop floor. 

2. Views: Seeing the Part from All Sides 

To really understand a part, you need to look at it from different angles; just like you’d 

turn a phone or a water bottle in your hand to see the top, bottom, and sides. 

In a production drawing, you’ll usually see: 

• Front view – the main shape 
• Top view – how it looks from above 
• Side view – usually the right side 
• Isometric view – a 3D-like image to help you imagine the full part 
• Section view – like slicing the part and showing what's inside. 

 

3. Dimensions:  How Big Everything Is? 

These are the numbers that show how long, wide, thick, or deep the part is. You'll also see 

sizes of holes, how far apart they are, or even the angles between two edges. 

You’ll often notice: 

• ⌀ (a circle with a slash) – that means diameter 
• R – this stands for radius 
• Numbers like 50 mm, 100 mm, or 45° 

 
How to read: Follow the arrows; see where they start and end, and read the number in 
between. That tells you the exact measurement. 

4. Tolerance: A Little Bit of Flexibility 

No machine in the world is perfect. So, we allow a small amount of "extra or less" in a size. 

This is called tolerance. 

For example: If a size is written as 60 ±0.1 mm, that means the part can be between 59.9 

mm and 60.1 mm, and it will still be okay. 

Tip: Always start by matching the views to imagine the 3D shape of the part. 
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Some drawings may show special tolerance symbols for things like flatness, straightness, 

or how round a hole is. Don’t worry, you’ll learn to recognize them over time. 

5. Surface Finish: How Smooth the Surface Should Be 

Some parts need to be smooth (like a sliding part), and some can be rough (like the inside 

of a welded box). Surface finish tells us how smooth the surface should be. You’ll see 

symbols like a tick mark (✓ or ⌖), and sometimes numbers like: 

• Ra 3.2 µm → that tells how rough or smooth the surface should feel. 

6. Material and Heat Treatment: What It’s Made of 

The drawing will tell you what material to use; like mild steel, Aluminium, or SS304 (a 

type of stainless steel). It may also mention if the part needs to be heated or hardened to 

make it stronger. This is called heat treatment. 

7. Threads and Holes: For Screws and Fasteners 

If the part has a threaded hole (for a screw or bolt), you’ll see something like: 

• M8 x 1.25: This means: a metric thread of 8 mm diameter with a 1.25 mm pitch 

(distance between threads). 

8. Notes: Extra Instructions 

There’s usually a list of instructions on the side, like: 

1. Paint this side only 

2. Do not drill before welding 

3. Assemble after polishing 

 

How to Read a Production Drawing Step-by-Step 

1. Start with the title block                   What is the part, material, and who made it? 

2. Look at the views                                Try to imagine the part in 3D. 

3. Check the dimensions                        See how big everything is. 

4. Look at tolerances                               Are any sizes very critical? 

5. See the surface finish                          Does it need to be smooth? 

Read the notes (Don’t skip them!) 

6. Check for threads or special holes 
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4.2 Introduction to Geometric Dimensioning and Tolerancing (GD&T) in 

SolidWorks 

Geometric Dimensioning and Tolerancing (GD&T) is a way to describe the size, shape, 

and position of parts in technical drawings. It helps engineers and manufacturers make 

sure that parts fit together correctly, even if they are made in different places. 

GD&T uses symbols to show how much variation is allowed in a part’s shape or location. 

These symbols give clear rules about what is correct and what is not. 

For example, if you are designing a hole that must line up with another part, GD&T can 

show the exact position the hole should be in. It will also tell how much it can be shifted. 

This is shown using a feature control frame, which includes symbols like: 

• ⌀ (diameter) 

• ⏊ (perpendicular) 

• ⌖ (position) 

Using GD&T in SolidWorks helps: 

• Avoid mistakes in manufacturing 

• Communicate design intent clearly 

• Reduce costs from rejected parts 

 

 

 

 

GD&T (Geometric Dimensioning and Tolerancing) is feature-based, using symbols   
grouped into five categories (Figure 4.2): 
 

1. Form Controls – Define feature shape: 
▪ Straightness: Line or axis straightness. 
▪ Flatness: Surface evenness between highest and lowest points. 
▪ Circularity: Roundness of a cross-section. 
▪ Cylindricity: 3D roundness—includes straightness, roundness, taper. 

 
2. Profile Controls – Define tolerance zones: 

▪ Line Profile: 2D contour accuracy within offset curves. 
▪ Surface Profile: 3D surface tolerance within offset boundaries (measured 

via CMM). 
 

To start using GD&T in SolidWorks: 
• Open your 3D part. 
• Go to Tools > DimXpert > Define Tolerance Features. 
• Choose the features you want to control. 
• Apply tolerances using GD&T symbols. 
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3. Orientation Controls – Control angle-related features: 
▪ Angularity: Surface flatness at a specified angle to a datum. 
▪ Perpendicularity: Surface flatness at 90° to a datum. 
▪ Parallelism: Surface or axis alignment at a fixed distance from a datum. 

 
4. Location Controls – Define feature positions: 

▪ Position: Most common; locates features relative to datums. 
▪ Concentricity: Compares axes of feature and datum. 
▪ Symmetry: Ensures equal spacing across a datum plane. 

 
5. Runout Controls – Control feature variation during rotation: 

▪ Circular Runout: Checks variation in a rotating part at a point. 
▪ Total Runout: Assesses entire surface variation—controls form, 

orientation, and profile. 
 

 
Figure 4.2: GD&T Symbols Overview 
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SESSION 2: TOLERANCE AND ITS SYMBOLS 

 
Tolerance is the allowed variation in size, shape, or position of a part during 
manufacturing. No machine can make parts that are 100% perfect every time, so 
tolerances help define how much deviation is acceptable without affecting the function of 
the part. 
 
For example, if a hole is supposed to be 10 mm in diameter, a tolerance might say it can 
be between 9.95 mm and 10.05 mm. If the hole is made within this range, it is considered 
acceptable (Figure 4.3). 
 

 
 

Figure 4.3: GD&T in SolidWorks 
 
There are two main types of tolerance in engineering drawings: 
 

1. Dimensional Tolerance 
 
This is used for the size of a feature (like length, diameter, or thickness). 
 

▪ Unilateral Tolerance – Variation is allowed in one direction only. 
Example: 50 +0.00/-0.10 → means size can go down to 49.90 but not above 
50. 

▪ Bilateral Tolerance – Variation is allowed in both directions. 
Example: 50 ± 0.10 → size can be between 49.90 and 50.10. 

▪ Limit Tolerance – Gives the maximum and minimum limits directly. 
Example: 49.90 – 50.10 
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2. Geometric Tolerance (GD&T Symbols) 
 

This defines tolerances for shape, orientation, position, and runout using standard 
symbols. These are placed in a feature control frame. 

 
Some common GD&T symbols and their meanings are given in Table 4.1. 
 
Table 4.1: Common GD&T symbols and their meanings 
 
 

Symbol Meaning 

⌖ Position 

∠ Angularity 

⏊ Perpendicularity 

∥ Parallelism 

∩ Profile of a surface 

⥁ Circular Runout 

◎ Concentricity 

⌯ Symmetry 

⌀ Diameter 

⬭ Flatness 

⌒ Circularity (Roundness) 

 
In SolidWorks, one can apply these tolerances using: 
 

▪ DimXpert for model-based dimensioning. 
▪ Tolerance options in drawing annotations 

 
SolidWorks lets you define and display both dimensional and geometric tolerances 
clearly on your 3D model and 2D production drawings. 

How to Read the drawing Step-by-Step:  

1. Start with the Title Block: Note the part name, scale, material, and drawing 

number 

2. Study the Views: Recognize the shape from the top, side, and front perspectives 

and to create the full 3D image in your mind, align views. 

3. Check Dimension: Pay close attention to all linear and angular measurements 

and to note the units (in inches or millimetres). 

 



 
 
  

71 
 

71 DRAUGHTSMAN MECHANICAL – GRADE XII  

4. Understand Tolerances: These tell how much variation is allowed in part size. 

 

5. Look for Section Views: Shows internal features not visible in external views. 

 

Following are the main GD&T control types used in SolidWorks: 
 
1. Profile (Profile of a Line and Profile of a Surface) 

 
Profile controls define the exact shape of a line or surface. Line profile manages cross-
sectional shape; surface profile covers full 3D surface. It is used to maintain form accuracy 
in curved or complex parts. It is applied in SolidWorks using DimXpert or MBD with the 
symbol ∩. 
 
2. Orientation (Angularity, Perpendicular, and Parallelism) 

 
Orientation controls how features are angled or aligned. Angularity ensures specific 
angles; perpendicular ensures 90° alignment; parallelism keeps surfaces evenly spaced. 
It is useful in assembling or positioning parts precisely. In SolidWorks, use DimXpert to 
apply symbols ∠, ⏊, and ∥. 
 
3. Runout (Circular Runout and Total Runout) 

 
Runout controls are used for rotating parts like shafts or wheels. Circular runout checks 
roundness at a section; total runout checks the full surface. It helps avoid wobbling and 
ensure smooth rotation. Applied using GD&T tools in SolidWorks with symbol ⥁. 
 
4. Location (Position, Concentricity, and Symmetry) 

 
Location controls define where features like holes or slots should be placed. Position 
control’s exact location; concentricity ensures shared centre; symmetry ensures even 
placement. Ensures proper fit, balance, and alignment of parts. SolidWorks uses 

DimXpert to add symbols ⌖, ◎, and ⌯. 
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Activity 1 

Aim: To Draw and Annotate 

Instructions: 

Draw a simple rectangular block with a hole in it. Now: 

• Add three 2D views (front, top, side). 

• Mark the hole using position control (⌖ ). 

• Add dimensional tolerances to one edge using ±0.10. 

• Add a note indicating material and surface finish. 

 
 
 

 
A. Multiple Choice Questions 

1. What does the symbol ⌀ represent in engineering drawings? 
A. Radius 
B. Surface roughness 
C. Diameter 
D. Perpendicularity 

  
2. What does a tolerance of 50 ± 0.10 mean? 

A. The part must be exactly 50 mm 
B. The part can range from 49.90 mm to 50.10 mm 
C. Only 49.90 mm is acceptable 
D. The tolerance is not defined 

 
3. Which of the following is a form control in GD&T? 

A. Position 
B. Perpendicularity 
C. Circularity 
D. Runout 
 

4.   What does the GD&T symbol ⏊ represent? 
A. Flatness 
B. Circular runout 

 

ACTIVITIES 

 

CHECK YOUR PROGRESS 
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C. Perpendicularity 
D. Surface profile 

 
5. In SolidWorks, which tool is used to apply GD&T annotations to a model? 

A. SimulationXpress 
B. DimXpert 
C. Render Tool 
D. Sketch Tool 

 
B.  Match the following  

 

Column A              Column B 

1. ⌖ A. Perpendicularity 

2. ∠ B. Symmetry 

3. ⏊ C. Angularity 

4. ⌯ D. Position 

5. ◎ E. Concentricity 

 
C. Fill in the blanks  

1. Production drawings are also known as _______________ drawings. 

2. _______________ tolerance allows variation in only one direction. 

3. GD&T symbols are placed inside a _______________ control frame. 

4. In SolidWorks, the tool used for applying GD&T is called _______________. 

5. A __________ drawing is a flat representation of a 3D object. 

 
D. Answer the Following 

1. Why are production drawings important in manufacturing? 

2. What does GD&T stand for, and what is its purpose? 

3. Name any three GD&T control categories. 

4. What is the use of DimXpert in SolidWorks? 

5. Explain the difference between circular runout and total runout. 
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Learning Outcomes 

 

After completing this module, you will be able to: 

• Understand the importance of collaboration in mechanical drafting projects. 

• Identify key elements of effective team management. 

• Apply principles of teamwork to achieve shared project goals. 

• Demonstrate essential team working skills in a technical environment. 

• Build effective working relationships within and outside the team. 

• Develop interpersonal skills to support strong customer relationships. 

 

 

Module Structure 

 

Session 1: Team Working Skills 

Session 2: Building Relationship with Customers 

 

 
In mechanical engineering, the draughtsman converts complex concepts into detailed 
technical drawings. While accuracy and technical skill are essential, "customer service" 
for a draughtsman involves more than just correct drawings. It includes being 
dependable, responsive, communicating clearly, and taking a proactive approach. These 
qualities ensure project success and build strong professional relationships.  
 
 
 
 
 
 

MODULE 5 CUSTOMER SERVICE 

Module Overview 

 

This module focuses on developing customer service skills essential for a Draughtsman 

Mechanical. It highlights teamwork, clear communication, and professional behaviour to 

meet client expectations. Emphasis is placed on building strong workplace relationships 

and maintaining accurate documentation. The aim is to ensure quality service through 

reliable and responsive project execution. 
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SESSION 1: TEAM WORKING SKILLS 
 

 
For a mechanical draughtsman, effective customer service guides every drawing, every 
change and every interaction. It is important to have a cordial relation with your co-
workers. Following are the basics that can help you out for achieving it: 
 
1. Collaborate with Co-workers: Mechanical design and drafting are rarely done 

alone. Projects typically involve many different specialists: engineers, designers, 
project managers, manufacturing experts, and other draughtsmen. Effective 
teamwork ensures smooth workflow, identifies issues early, and combines 
knowledge for better results. 

 
Poor collaboration leads to communication problems, duplicated efforts, conflicting 
designs, and a disorganized approach. This reduces project efficiency and quality. Good 
customer service includes being a reliable and supportive team member. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

How to Achieve? 
 

• Maintain Open Communication: Do not hesitate to reach out. Use 
shared platforms (such as Teams, Slack, email, or project 
management tools) to ask questions, provide updates, and share 
progress. 
 

• Share Information Proactively: If you complete a part of a drawing 
that another team member needs, inform them immediately. Do 
not wait for them to ask. For example: "The bracket assembly 
drawing, revision B, is now available in the shared drive. 

 
• Participate in Design Reviews: Actively contribute to design 

reviews. Offer your insights on how easily parts can be 
manufactured, the clarity of drawings, and potential conflicts 
between components. Your knowledge of drawings is very 
valuable. 

 
• Provide Constructive Feedback: Be open to feedback on your 

drawings and offer helpful feedback to others when reviewing 
their work. The goal is to improve the overall project outcome, not 
to criticize individuals. 

 
• Offer Support and Guidance: If a colleague is facing difficulties, 

offer assistance. Share best practices or solutions. Helping others 
helps the entire team succeed. 
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Why Coordination in a teamwork is required? 

 
1. Team Management: In any technical job role, especially that of a Draughtsman 
Mechanical, team management plays a significant role in achieving organizational goals. 
It involves coordinated efforts that align each team member’s work with the broader 
objectives of a project. Efficient team management not only enhances productivity but 
also helps in fostering a collaborative work environment.  
                                                                                                         
 

Characteristics of a Good/Effective Team 
 

• Elevating Goal: A shared vision or goal must be clearly communicated to all 
members. 

• Result-Driven Structure: All team members collectively agree on the goals and 
commit to achieving them. 

• Competent Members: Each team member should possess the necessary skills to 
contribute effectively. 

• Unified Commitment: The team should work with a shared sense of purpose. 
• Collaborative Climate: A cooperative environment helps team members stay 

motivated and focused. 
• Standards of Excellence: Consistent quality output should be a top priority to 

achieve team success. 
 
 
 
2. Teamwork: Teamwork is the collective effort of all members working towards a 
common goal. For a draughtsman, this could mean working alongside engineers and 
fabricators to produce error-free mechanical drawings (Figure 5.1).  

 
  
 
 
 

 
 
 

Figure5.1: Teamwork 
 
 
 

 
  

 
 

 
 
 
 

 
 



 
 
  

77 
 

77 DRAUGHTSMAN MECHANICAL – GRADE XII  

Key Principles of Teamwork:  
 

1. Put the Team First: Prioritize team objectives over individual preferences. 
2. Respect Team Members: Never underestimate others’ contributions. 
3. Encourage Open Discussions: Any new idea should be openly discussed 

before implementation. 
4. Avoid Criticism: Encourage mutual support rather than criticism. 
5. Promote Transparency: Maintain honesty and clarity in communications. 
6. Leader’s Responsibility: Team leaders must encourage performance and 

resolve conflicts swiftly. 
7. Conflict Avoidance: Settle issues through discussions and compromise. 
8. Reward & Recognition: Promote healthy competition through timely 

recognition. 
 
  3.  Team Working Skills: Being an effective draughtsman requires more than technical    
      skills. It involves the ability to work well with others. Whether you're creating 2D    
     drawings or collaborating on a CAD model, teamwork is essential (Figure 5.2). 

 
Essential Team Working Skills: 

• Reliability: Complete assigned work consistently. 
• Constructive Communication: Share thoughts respectfully and clearly. 
• Active Listening: Understand others’ views without reacting defensively. 
• Participation: Engage in team discussions and activities. 
• Information Sharing: Keep the team informed of progress and findings. 
• Cooperation: Offer help and respond positively to requests. 
• Flexibility: Adapt to changes in project scope or approach. 
• Commitment: Show dedication to team goals and outcomes. 
• Problem Solving: Focus on solutions rather than complaints. 

 

 
 

Figure 5.2: Team Working Skill 
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SESSION 2: BUILDING RELATIONSHIP WITH CUSTOMERS 
 

 
4.1 Maintaining Good Relationship with Customers 
 
In any engineering or technical environment, especially for a Draughtsman Mechanical, 
maintaining healthy interpersonal relationships is not just important; it is essential. 
Strong internal relationships with colleagues, supervisors, engineers, and even external 
stakeholders form the core of an efficient and customer-focused work culture. Good 
workplace relationships help reduce miscommunication, foster cooperation, and 
ultimately reflect positively in the quality of customer service delivered by the team or 
organization. 
 
Key Traits of a Good Work Relationship 
 

• Trust: Trust is the foundation of effective collaboration. A trustworthy 
draughtsman can be relied upon to complete assigned tasks accurately and on 
time. Trust within teams ensures that information is shared openly, errors are 
corrected constructively, and customer-facing work (e.g., project delivery) is 
reliable and consistent. 
 

• Mutual Respect: In design-based roles, every contribution—from initial sketches 
to final drawings—has value. Respecting colleagues’ roles and feedback ensures 
designs are not only technically sound but aligned with customer needs. 

 
• Mindfulness: Being mindful of tone, attitude, and behavior in discussions 

improves communication and reduces unnecessary friction. A mindful team 
member is aware of how their conduct affects team dynamics and, ultimately, 
customer satisfaction. 

 
• Welcoming Diversity: Embracing different perspectives from team members 

often leads to innovative solutions. For customers, this means better, more 
efficient design outcomes driven by diverse input. 

 
• Open Communication: Keeping everyone on the same page—especially 

regarding changes in drawing specs, client feedback, or project deadlines—
supports smoother project execution. Open communication minimizes rework 
and delays, thereby enhancing client satisfaction. 

 
4.2 Where and How to Build Good Work Relationships 
 
Good work relationships should be built at every level of the organization. For a 
Draughtsman Mechanical, these relationships not only support internal coordination but 
also strengthen customer service delivery through efficient workflows and quality 
assurance. 
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Key Professional Relationships 
 

• Supervisors and Managers: Regular interaction with supervisors ensures 
alignment on project goals, priorities, and timelines. Clear understanding of client 
requirements; often communicated through senior staff, is crucial for delivering 
accurate mechanical drawings. 
 

• Project Collaborators: Working alongside design engineers, site supervisors, 
quality checkers, and fabricators ensures that drawings are practical and aligned 
with on-site conditions. This collaboration is essential for fulfilling customer 
specifications without costly errors or delays. 

 
• External Vendors or Clients: Occasionally, draughtsmen interact directly with 

clients or third-party service providers. Professional and respectful 
communication builds trust and demonstrates commitment to customer service 
excellence. 

 
4.3 Ways to Build Strong Relationships 
 
Following are the ways to build strong relationships as follows: 
 

• Develop People Skills: Soft skills such as empathy, listening, and emotional 
intelligence are as valuable as technical proficiency. Being approachable and 
respectful improves both internal dynamics and external service delivery. 
 

• Schedule Relationship-Building Time: Even brief informal interactions, like 
checking in with a colleague or updating a supervisor; can strengthen professional 
bonds. 

 
• Show Appreciation: Acknowledging others’ support or input builds goodwill. For 

example, appreciating the help of a quality engineer in resolving a drawing 
discrepancy demonstrates team spirit and accountability—qualities customers 
value. 

 
• Stay Positive: A positive, solutions-focused attitude not only improves morale but 

ensures that challenges are handled in ways that minimize customer impact. 
 

• Avoid Gossip: Professionalism demands that personal opinions and conflicts are 
handled maturely. Gossip or negativity affects teamwork and can indirectly 
damage the client experience through poor internal communication. 

 
• Listen Actively: Understanding other’s concerns and suggestions without 

jumping to conclusions fosters mutual respect and ensures better decision-
making; which is reflected in the accuracy and relevance of customer deliverables. 

 
4.4 Diaries and Log Reports 
In a customer-oriented work environment, transparent and accurate documentation is 
critical. For a Draughtsman Mechanical, maintaining detailed diaries and log reports not 
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only ensures internal coordination but serves as a verifiable record of activities, 
decisions, and communication; often vital for maintaining project timelines and quality. 
 
A daily log is a structured record maintained by the draughtsman or supervisor, detailing 
key activities and progress. It ensures project transparency and provides stakeholders, 
including customers, with timely updates if needed. 
 
Key elements include: 

• Date and Activity Summary: Helps track day-to-day progress. 
• Drawing Revisions: Logs changes, reasons for modifications, and approvals, 

ensuring the final product meets customer expectations. 
• Equipment Usage: Tracks CAD and other tools for accountability. 
• Delays or Rework: Identifies causes and mitigation steps taken. 
• Team Interactions: Notes critical decisions and briefings. 
• Reference Material Used: Documents codes, standards, or templates applied. 

 
4.5 Importance of Site Diaries 
 
Site diaries are personal records maintained by draughtsmen or field engineers, 
offering detailed insights into daily activities. For mechanical drawing professionals, 
these diaries serve several purposes: 
 

• Record of Drawing Activities: Captures progress, challenges, and revisions. 
 

• Client Instructions: Logs discussions or directions given by customers or their 
representatives. 

 
• On-Site Observations: Notes feasibility checks or design changes due to real-

world constraints. 
 
4.6 Daily Field Reports: 
Often prepared by supervisors but sometimes contributed to by draughtsmen, these 
reports include: 

• Weather Conditions: Relevant if affecting site drawing validation. 
• Site Visitors: Record of client or consultant visits. 
• Equipment Used: Tracks availability and usage. 
• Feedback from Engineers/Supervisors: Useful for verifying drawing 

compliance and maintaining alignment with customer expectations. 
 

Field reports help demonstrate transparency to the client and confirm that the project is 
progressing as planned. 
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Activity 1 

Aim: To practice communication and teamwork when dealing with client-
driven changes. 

Steps to be followed: 

• In pairs, one student acts as the draughtsman, the other as the client. 
• The client requests a minor change in a mechanical part drawing (e.g., hole 

size or material). 
• The draughtsman listens, asks clarifying questions, and explains the 

impact. 
• After the discussion, the draughtsman notes the change in a log sheet. 

 

 

CASE STUDY 
 
Amit, a draughtsman working on the HVAC layout for a commercial building, noticed 
during a site visit that a duct route shown in the approved design drawing would clash 
with a newly added structural column. Instead of waiting for instructions, he immediately 
consulted the site supervisor and design engineer to propose an alternate route. He 
updated the CAD drawing accordingly, logged the revision in the daily log report, and 
mentioned the client representative's verbal approval in his site diary. This proactive 
approach prevented a delay in duct installation and avoided additional costs. The client 
appreciated the quick response and highlighted Amit's professionalism in their review 
meeting. 
Question: 
How did Amit’s use of documentation and collaboration help prevent delays and build 
trust with the client? 
Solution: Amit’s use of documentation and collaboration was key to preventing delays 
and building trust. By proactively identifying the issue and immediately consulting the 
site supervisor and design engineer, he ensured that the drawing was corrected before 
installation began. Updating the CAD drawing, recording the revision in the daily log, and 
noting the client’s verbal approval in his site diary provided a clear, traceable record of 
the decision. This transparency reassured the client that the changes were handled 
professionally and efficiently, reinforcing their trust in the team’s capability and 
commitment to quality. 
 
 

 
ACTIVITIES 
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Activity 2 

Aim:  To practice daily documentation relevant to drafting work. 

Steps to be followed: 

• Provide a mock scenario: e.g., "Reviewed bearing assembly drawing, made 

changes after feedback from the senior engineer. CAD software update 

caused a 30-minute delay." 

• Students fill in a Daily Log Sheet with: 

o Date 

o Tasks completed 

o Team interaction 

o Drawing version or changes 
o Any delays or issues 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
                               CHECK YOUR PROGRESS 

 

 

A. Multiple Choice Questions 

1. Which skill is essential for building strong customer relationships? 

A. Ignoring team feedback 

B. Technical drawing only 

C. Interpersonal communication 
D. Avoiding documentation  

2. Which of the following is a key trait of an effective work relationship? 

A. Strict supervision 

B. Gossip 

C. Mutual respect 
D. Speedy drawing 

3. What is the purpose of a daily log report? 

A. Personal journaling 

B. Tracking machine performance only 

C. Documenting daily work progress and decisions 
D. Recording lunch breaks 

4. Which document helps verify that site activities align with client expectations? 
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A. Marketing report 

B. Resume 

C. Daily field report 
D. Training manual 

5. What kind of attitude is encouraged to build workplace relationships? 

A. Negative and reactive 

B. Positive and solution-focused 

C. Passive and quiet 
D. Independent and isolated 

 

B. Match the following   

 

Column A Column B 

1. 
 

Customer communication A. Builds strong team collaboration 

2. Daily updates B. Helps in resolving issues collectively 

3. Coordinating with team C. Avoids errors in manufacturing 

4. Team discussions D. Enables better planning and 
coordination 

5. Accurate drawings E. Helps maintain trust and satisfaction 
 

 

C.   Answer the following 

1. What does “customer service” mean for a Draughtsman Mechanical beyond just 
technical drawing accuracy? 

2. List any three essential team working skills a draughtsman should possess to work 
effectively with co-workers. 

3. Why is maintaining a daily log important for a Draughtsman Mechanical in a 
project environment? 

4. What are the key professional relationships a draughtsman should focus on 
building in the workplace? 

5. How do diaries and log reports contribute to customer satisfaction and project 
transparency? 

 
D.  Read the Case Study and answer it: 
 
Nisha, a senior draughtswoman, was preparing mechanical layout drawings for a high-
pressure boiler system in a thermal power plant. Mid-project, the client introduced new 
safety regulations that required significant design alterations. The design team was 
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unavailable due to an ongoing audit, and the deadline was tight. Nisha reviewed the 
updated codes and consulted archived reference standards and previous project 
drawings. She proposed technically sound modifications and documented each step, 
including safety rationale, in the daily log and revision history. Once the design team was 
available, her detailed notes and compliance references helped gain quick approvals 
without project delay. However, a consultant later challenged one of her changes. Thanks 
to her comprehensive site diary and reference documentation, Nisha justified her 
decisions with confidence, and the consultant's concern was resolved without escalation. 
 
Question:  
What role did Nisha’s technical knowledge and thorough documentation play in 
managing unexpected regulatory changes under time pressure? 
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Dimension – A measurement that shows the size (length, width, height) of a part. 
 
Tolerance – The allowed variation in size that is acceptable during manufacturing. 
 
Surface Finish – The texture or smoothness of a part’s outer surface. 
 
Material Specification – Information about the type of material to be used. 
 
Section View – A cut-through view that shows the inside of a part.  
 
Isometric View- A 3D-like drawing that shows how a part looks from an angle. 
 
Front View – The main side of a part as seen from the front. 
 
Top View – A drawing that shows the part as seen from above. 
 
Right-Side View – A drawing that shows the part as seen from the right side. 
 
Title Block – The box on a drawing that gives details like part name, date, scale, etc. 
 
Centreline – A dashed line that shows the center of holes or symmetrical features. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
GLOSSARY 
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MODULE 1: FUNDAMENTALS   OF CAD 

 

A. Multiple Choice Questions 

1- C   2- C    3-C   4-B     5-C 

B. Match the following 

1-D     2-A 3-E 4-B 5-C 

C. Fill in the blanks 

1. CPU                                    2. Keyboard                                                                                                              

3. Mechanical                      4. edits (or modifications)                                                                                         

5. Inte2rnet 

 

MODULE 2: LEARNING COMMANDS IN CAD 

A. Multiple Choice Questions 

1-C     2-B      3-C    4-C    5-B 

B. Match the following 

1-E    2-C   3-B   4-A   5-D 

C. Fill in the blanks 

1.  CAD       2. Line 

3.  Linear Sketch     4.  Circle 

5. Trim 

 

MODULE 3: 2D DRAFTING IN SOLIDWORKS 

A. Multiple Choice Questions 

1-B   2-C   3-C   4-C   5-B 

 

B. Match the following 

 
ANSWER KEY 
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1-B   2-A   3-E   4-C   5-D 

 

C. Fill in the blanks  

1. documentation                                                2. Drawing                                                                                        

3. Dimension                                                        4.tangent arc                                                                             

5. DWG 

 

MODULE 4: READING PRODUCTION DRAWING 

A. Multiple Choice Questions 

1- C   2-B   3-C   4-C   5-B 

B.  Match the following  

1-D 2-C 3-A 4-B 5-E 

C. Fill in the blanks 

1.  Manufacturing      2. Unilateral 

3.  Feature      4. DimXpert 

5. 2D  

 

MODULE 5: CUSTOMER SERVICE 

A. Multiple Choice Questions 

1-B   2-C   3-C   4-C   5-B 

B.  Match the following  

 1-E    2-D   3-A   4-B   5-C 

 

 

 

 

 

 


